
NEWSLETTER #70 - September 2018

It might be quite a COUPas we regale the latest Power BI updates, supply more in our 
ongoing series of A to Z of Excel Functions (hence the pun) and fill you in with what’s being going on in Excel Online, a variant we all too 
often forget.  

We even have a new series for you: it may have a limited shelf life on other platforms but VBA refuses to die.  So if you 
can’t beat ‘em we’ll join ‘em as we take a look at the elementary side of the macro in Visual Basics.  It’s not our only 
ongoing series though – as it joins Power Query Pointers and our Keyboard Shortcuts!

Happy reading and see you next month

99% of this newsletter seems to be about updates and we start off our September edition proving that our lead article is no exception to the rule.  
Excel Online has been neglected for a good while and to be honest, we don’t notice too many of our clients using it, given all its perceived limitations.  
And don’t get us wrong, having tried to work with an online Table recently, there’s still a few improvements to be made!

However, over the past couple of years, Microsoft has been working hard to improve its usability.  Are you familiar with all the upgrades?   
We take a look below.

Excel Online Updated
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It’s now possible to adjust row height and column width from the context menu.  Just right-click on a row or column label, and you’ll see the option.

Click ‘Row Height’ or ‘Column Width’, enter a new value, and the selected row or column is adjusted.  A valuable benefit of this is that you can now 
select multiple rows or columns and set them all to a specific height or width with just a few clicks.

Adjusting Rows and Columns
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If you want to resize a row or column without using the context menu, you can just grab the border and drag it to the desired size.  Microsoft recently 
added a new feature for when you’re dragging a column to a new size: a tooltip that displays the column width.

In previous editions of Excel Online, if you wanted to duplicate a sheet, you’d have to create a new sheet and then copy and paste data from the 
original sheet.  Now, you can just right-click a sheet tab and select ‘Duplicate’.

Working on spreadsheets with a large number of sheets can be difficult.  To assist, Excel Online now lets you change the colour of a sheet tab so you 
can find it quickly or categorise your sheets.  Just right-click on the sheet tab, mouse over ‘Tab Color’, and select the colour you’d like.

A new sheet will appear that is an exact copy of the first.  At the moment, sheets with charts, images or shapes still can’t be duplicated.  But it’s a start.

Your sheet will now be highlighted with the selected colour.

If you know how wide you want the column to be, or you’d like to make different columns the same width, this makes it much easier.

Column Width Tooltip

Duplicate Sheet

Change Sheet Tab Colo(u)r
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When you’re working with lots of data in the desktop version of Excel, ‘Freeze Pane’s is one of the most useful tools to know.  By freezing the top 
row, your column headings are always visible.

 You can now freeze any number of columns or rows in Excel Online, too.  Just click into a cell and click View > Freeze Panes > Freeze Panes to freeze 
everything above and to the left of it.

Much of the added formatting power comes from 
new options in the Ribbon.  The ‘Home’ tab now 
gives you access to a full selection of formatting 
options that you’ve become accustomed to in the 
full desktop version of Excel. 

You can quickly select number formatting options 
from the ‘Number’ drop-down to format your 
number as a percentage, currency, date, or other 
options.  Currency and accounting formats and 
alignment options are also available from the same 
part of the ‘Home’ tab.

Many of Excel’s text formatting options are also 
easily available at the click of a button.  For example, 
additional typeface formatting options like double-
underline and strikethrough are easily accessible in 
the Font area. 

More number formats are available from the 
number formatting drop-down in the centre of the 
‘Home’ tab.

You can also select View > Freeze Panes > Freeze Top Row or Freeze First Column for the most commonly used freeze pane commands.

Freeze Panes

Changes in the Ribbon
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A full selection of border types, merging and unmerging, increasing and decreasing indentation, font size and other formatting options are available 
for both numbers and text as well.  Additionally, Microsoft added the 'Most Recently Used’ split button to the ‘Borders’, ‘Fill Color’ and ‘Font Color’ 
buttons in Excel Online.

When you set a colour or a border from these buttons, Excel Online will now remember it, so you can just click the button to apply it somewhere else.

When Excel Online was a simple spreadsheet viewer, there was no way to insert shapes or pictures into a spreadsheet.  The new version of Excel 
Online can now do more.  The ‘Insert’ tab now prominently features buttons for inserting pictures and shapes – and the menu of shapes contains 
just about any shape you could ever need.

By changing the format of a subset of cells, conditional formatting makes it easy to highlight the cells you want based on what they contain.  
Conditional formatting tools are now prominently displayed in the ‘Home’ tab, viz.

It’s easy to click and drag the image or shape into place, and the rotation handle lets you rotate it into any orientation you’d like.  Also, you can now 
change the shape and border colour, as well as dimensions (width and length).

Shapes and Pictures

Conditional Formatting
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Just select the data you want to format, click ‘Conditional Formatting’, and select the formatting you’d like to apply.  Here’s what it looks like when 
we apply Highlight Cells Rules > Above Average.

When you have a lot of data, being able to effectively filter it down to the information you want to see is crucial.  The ‘Data’ tab now hosts a ‘Filter’ 
button that enables column-based filtering, just like in the desktop version of Excel.

Filtering

The in-spreadsheet dropdown doesn’t contain individual-value filtering, but if you click ‘Filter’, you’ll see the familiar options for viewing only  
certain values.
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Excel Online makes it to the 20th century!  Long considered one of Excel’s most essential data analysis features, PivotTables give you powerful 
summaries of your data.  Before Excel Online supported PivotTables, the desktop version of Excel was considered to be vastly superior.  Now, it’s 
just superior… 

After PivotTables, Excel Online now gives you the power to work more effectively with regular Tables as well.  When having a Table in your spreadsheet, 
you can include additional rows or columns in your table by right-clicking.

Perhaps the most useful feature that Excel Online brings to the table (not the one above!) is collaboration.  This is a real raison d'être for Excel Online.  
Instead of emailing files back and forth with other Office users, you can have an entire group of people working on a document in real time.  If Excel 
Online were to work properly, let’s face it, we’d all use it.

Making the change from a spreadsheet viewer to editor required 
Microsoft to make some big changes in the backend functionality of the 
application.  For example, previous versions of Excel Online couldn’t 
open protected workbooks.  The latest version has no problem opening 
or editing these protected files.

Previous versions also couldn’t edit files that contained cropped 
images—which made it difficult to collaborate with people on files that 
included images.  Now, however, Excel Online has no problem editing 
files with cropped images.

 The same is true of files that contain grouped shapes or images.

Excel Online has also seen some additional performance upgrades. You 
can now work with Excel files of up to 30MB if you have OneDrive for 
Business.  That’s three times the previous limit.  It’s also been upgraded 
with more power, so page load times will be lower and you’ll see 
improved interactivity from the app itself.

Working and living in Australia, we’re no novices when it comes to 
working with lousy internet.  Wherever you are in the world, your 
Excel Online session can end while you still have your file open.  In 
previous versions of Excel Online, you’d have to wait until your browser 
reconnected to the service to start working on the spreadsheet. 

Now, however, you can start working on the file while your browser  
re-establishes the connection.  It might not seem like much, but it 
eliminates a potentially annoying wait when you’re trying to get  
work done.

The context menu also lets you delete rows and columns with a single click.  

Another new feature is the ability to navigate through the table by pressing the Tab key on your keyboard, so you can navigate to the cells you want 
faster than ever without using your mouse.

To our mind though, this feature still has a long way to go, with an inability to toggle filtering.

PivotTables

Tables

Collaboration

From Viewing to Editing

Silent Reopen
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With the ‘Share’ button, you can share your Excel Online spreadsheet with other users and everyone can edit the document at the same time.  Just 
imagine the dog’s breakfast you could make.

From here, you can choose who you’ll invite to your spreadsheet and select if they’ll be able to edit it or view it only.

You can also tick an option that forces the invited to log in to their Office account before they can view or edit the spreadsheet.  When you’ve shared 
your file, you’ll see who’s editing, which cell they have selected and the exact changes that they make.

Real-Time Co-authoring
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You can also leave comments to each other and chat while you’re editing right in Excel Online.  With the built-in Skype messenger, you may also chat 
with your contacts in the same window as your spreadsheet:

In early versions of Excel Online, if you clicked on a cell and dragged the selection to the bottom (or right side) of the viewport, the selection would 
stop there—you couldn’t scroll.  Now, you can click and drag to scroll and select as many cells as you want.

A new ‘Print’ dialog can be accessed from the ‘File’ tab of the Ribbon.  This dialog gives you more options to help you get a better print of your 
spreadsheet.

Choose what you print, how you print it and what you print it on all in one place.

Drag Scroll Beyond Viewport

Printing
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Excel Online now includes the ability to create online forms that you can use to collect and analyse survey information.  Just go to the ‘Home’ tab, 
click ‘Survey’, and select ‘New Survey’.

The ‘Accessibility Checker’ tells you when users with disabilities might 
find your document hard to read and how you can fix the issues.  There 
are improved screen reader support and a new high-contrast mode for 
visually impaired users, too. 

Excel Online also has the same ‘Tell me what you want to do’ feature that 
desktop versions have, making it easier for people who aren’t familiar 
with Excel to find what they want.  This, combined with improved 

keyboard shortcuts for getting around the app, makes it more accessible 
for everyone.

There’s no doubt it’s getting better, but aside from surveys and 
collaborations, we’re probably going to stick with its desktop counterpart 
for the time being, thank you for asking.  But we will be keeping an eye 
on the future improvements…

Grouping in Power Query is not intended to replace the excellent tools available in Excel spreadsheets to group and summarise data.  Power Query’s 
talent is its ability to manipulate very large data sets, and it can be useful to group data before uploading to an Excel spreadsheet so that there are 
less rows to deal with.

In a previous article, we showed how to merge ‘Order Charges’ with ‘Group’ information from a database.

Then enter your survey questions.

After that, you can share your survey and all results will be immediately imported into Excel Online, so you can analyse and share them.

Excel Surveys

Accessibility

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at grouping.

Power Query Pointers
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This time around, we will go back to this example query and try some grouping.  To keep things easy to follow, let’s begin by removing the columns 
we are not interested in– the various keys that would help us to link to other queries. 

We are going to group by Item_Group and Description.  To do this, we select the Item_Group column, and then choose the ‘Group By’ section on 
the ‘Transform’ tab:

There are a few options to explore here – we’ll begin by using the ‘Add grouping’ button to include the Description column. 
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Power Query has helpfully suggested what we might like to do – count the rows. We’d like a better name for this column – ‘Items Sold’ , and then we 
want to use the ‘Add aggregation’ button to add another column to sum my Amount. 

The column section is populated if Power Query needs to know what the ‘Operation’ should be performed on.  Click on ‘OK’ to see how my data has 
been grouped, and then apply a sort.

The data is now ready to load.  Since it is grouped there are now less rows to upload, which illustrates how grouping in Power Query assists any work 
done in Excel.
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Voila! 

VBA (Visual Basic for Applications) is a programming language developed 
by Microsoft and is built into Excel and other Office programs.  It enables 
building your own functions (known as User Defined Functions or UDFs 
for short), automating processes and interacting with libraries to work 
with the Windows operating system.  It is also used to write some of the 
custom add-ins for Office applications.

In Office for Mac, VBA was upgraded in 2016 but some features and 
certain commands do not function correctly and herein lies the problem: 
it doesn’t work everywhere – but lots of people use it as a readily 
accessible porthole for Microsoft Office and often Excel in particular.

You can’t say “VBA” without talking about macros.  A macro is simply 
a sequence of actions that can be executed together, written in VBA.  
Office applications (apart from PowerPoint) allow the “recording of 

macros” where every single step performed is recorded and translated 
to Visual Basic code.  After recording / writing a macro, these bits of code 
can be reused to automate these actions.

This is all well and good, but macros are disabled by default in the Office 
applications.  This is because VBA scripts may be automatically executed 
whenever a spreadsheet is opened – and that’s not good given all those 
nasty people out there.  Some scripts can be malicious and cause issues 
on your machine.  For example, some VBA scripts can delete files and 
your Outlook email address book.

To change the security settings for macros, these may be accessed in 
‘Excel Options’ (ALT + T + O) in the ‘Trust Center’ group in the resulting 
left-hand column of the dialog box.  Once there, click on the ‘Trust Center 
Settings…’ button, viz.

It’s not all about the Power Tools, you know.  We thought we’d run a new elementary series going through the rudiments of Visual Basic for Applications 
(VBA) as a springboard for newer users.  This first part starts with the most basic of Visual Basics.

Visual Basics
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Under the ‘Macro Settings’ group, a set of options is presented:

Excel defaults to ‘Disable all macros with notification’.  This means that whenever a workbook has a macro (only .xls, .xlsb and .xlsm files may have 
macros) a pop-up warning window will appear before opening a file:

The ‘Excel Options’ menu will pop up.  On the right-hand side, you’ll see “Customize the Ribbon” where you can click which tabs are to be visible.  
Click on the check box next to ‘Developer’ and select ‘OK’.

This is a little confusing for older users of Excel as the default is similar to 
Excel 2003, even if the setting starts with ‘Disable’.  It’s not the only thing 
you have to do, mind you.

To fully utilise VBA in Excel, you need to have access to the ‘Developer’ 
tab, which shows the VBA tools available.  By default, the Developer tab 
of the Ribbon is not made visible.  To enable this as well, right-click on 
the Ribbon and select ‘Customize the Ribbon…’:
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Then we’ll see the ‘Developer’ tab on the screen. 

You’re good to go!

August Updates for Power BI Desktop

After the avalanche of updates last month (nothing to do with the Microsoft Business Applications Summit we’re sure), normal service has been 
resumed this month with a more reasonable number of updates to get your teeth into.

The August updates are as follows:

Reporting

	 •	 Print reports through Export to PDF
	 •	Create bookmark groups
	 •	 Theming Generally Available
	 •	 Slicer restatement

Analytics

	 •	 Conditional formatting by values
	 •	 Python integration (Preview)
	 •	Q&A improvements:
			   o	 Q&A in Power BI Desktop Generally Available
			   o	 Better matching experience for Power BI Desktop and Power BI Premium

Modelling

	 •	Data categories for measures
	 •	 Statistical DAX functions
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Custom Visuals

	 •	 3AG Systems Column Chart with Variance
	 •	 Scatter Chart by Akvelon
	 •	 Small Multiples Line Chart
	 •	Add Natural Language Summaries for BI
	 •	 Pivot Slicer

Data Connectivity

	 •	 Spark connector Generally Available.

As usual, let’s go through each new feature in turn.

Print reports through Export to PDF

Many have mentioned in the various feedback fora that they would like Power BI Desktop to easily print or email copies of their reports out to others 
in their company.  This month’s update now allows you to export all visible report pages to PDF.  This new option is located under the ‘File’ menu. 

Once you select ‘Export to PDF’, Power BI will start generating the PDF.  At 
the same time, a dialog will be displayed that lets you know the software 
is busy working on it, and you’ll see each non-hidden page loading in 

order behind it.  During this process, you won’t be able to interact with 
the report.  If you need to interact with your report again before we’ve 
finished you can cancel the export through the dialog. 

Once the PDF has been created, it will open in your default PDF viewer, which defaults to Microsoft Edge (ah well, can’t have everything).  From there 
you can save it wherever you like, email it as an attachment or print it.
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Currently export to PDF is only supported in Power BI Desktop.  In the Power BI service, you can still use the normal ‘Print’ option that is available. 

Currently, Power BI does not support printing wallpaper colour or images, only page backgrounds or images.  If you have a dark wallpaper color and 
a transparent page colour, as a tip, you may wish to temporarily set the page background to match the wallpaper’s colour to improve readability. 

If you use bookmarks extensively, there’s a good chance you’ll have tried 
to group them for different purposes / alternatives.  For example, you 
may have different bookmarks per organisational division using your 
report or perhaps you have a set of bookmarks for navigation and several 
sets of bookmarks for different presentations. 

In these cases, it’s important to clearly separate out each group of 
bookmarks, and this update introduces bookmark grouping.  This allows 
you to collect a set of bookmarks together and give it a name.  Each 
group can be expanded and collapsed for easy viewing.

Create bookmark groups
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If you use bookmarks extensively, there’s a good chance you’ll have tried 
to group them for different purposes / alternatives.  For example, you 
may have different bookmarks per organisational division using your 
report or perhaps you have a set of bookmarks for navigation and several 
sets of bookmarks for different presentations. 

In these cases, it’s important to clearly separate out each group of 
bookmarks, and this update introduces bookmark grouping.  This allows 
you to collect a set of bookmarks together and give it a name.  Each 
group can be expanded and collapsed for easy viewing. 

To create a bookmark group, click the first bookmark of the group and then CTRL + CLICK the other bookmarks you want to group with it.  Then select 
the ‘…’ menu for any of the bookmarks to group and pick the ‘Group’ option.

If you decide later you do not require that group anymore, just use ‘Ungroup’ to stop grouping that set of bookmarks. 

When you use ‘View’ to play a bookmark group, it will only include the bookmarks in that group.

Playing from a bookmark at the root level, such as ‘Default View’ in this example, will still play through all bookmarks in your pane. 

Create bookmark groups
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Last month saw a major update for theming that added support for the 
remaining visuals properties and page level background and wallpaper 
colours.  At this point, Microsoft has stated that they are satisfied with 
their level of theming support across report pages hence they are making 

theming Generally Available.  This means you may start using it without 
needing to enable it through the ‘Options’ dialog.  Microsoft has also 
advised this feature will be finding its way into next update of Power BI 
Desktop for Report Server too.

There’s a new type of conditional formatting for tables and matrices this 
month: format by field value.  ‘Format by field value’ allows you to use a 
measure or column that specifies a colour, either through a hexcode or 
name and applies that colour to the background or font colour. 

For example, each product in any given model has a colour.  Instead of 
showing the colour name, you may set the cell to be filled with the colour 
instead. 

With this feature, all you have to do is pick to format that colour by the colour name.  You can do that by opening the ‘Conditional Formatting’ dialog 
for the ‘Color’ column in the example table (below): 

If you are using the list slicer, you can now add a restatement, similar to the restatement in the dropdown slicer, to the slicer header through an 
option in the ‘Slicer header’ card in the ‘Formatting pane’.

Theming Generally Available

Conditional formatting by values

Slicer restatement
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Then, in the dialog, pick to format by Field value.  The dialog defaults to the ‘Color’ column with ‘First for summarization’.  Since there will always 
only be one colour value per table row, this is exactly what is required and you would just need to click ‘OK’. 

If you repeat this for font colour as well, the whole column will be filled with the product colour, which makes it easier for you to identify with a glance 
which product colour you are currently looking at.   

Another example for this is to set up DAX calculations based on your business logic that outputs different hexcodes.  You can then format by that 
calculation without having to worry about creating several cumbersome rules in the ‘Conditional Formatting’ dialog. 

After selecting this option, you’ll be able to paste in your script.

This update sees Python, a programming language widely used by 
statisticians, data scientists, and data analysts, is now integrated into 
Power BI Desktop.  Once you enable the feature in the Preview settings, 
you can use Python to do data cleansing, analysis, and visualisation.

The first integration experience added is the ability to run Python scripts 
directly in Power BI Desktop to create your data model.  You’ll see an 
option for this new connector in the ‘Get data’ dialog.

Python integration (Preview)
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The Python integration in the Query Editor lets you perform data 
cleansing using Python and perform advanced data shaping and analytics 
in your data, including completion of missing data, predictions, and 
clustering, just to name a few.

You may also use Python to create new visuals on your report.  Just like 
R visuals, the Python visuals will update with data refreshes and cross-
filtering.  However, the visual itself is not interactive.

This month sees Q&A in Power BI Desktop become Generally Available.  This means you’ll no longer need to turn on the Preview feature to use Q&A 
for visual creation or the Q&A Explorer in your reports.

Q&A in Power BI Premium and in Power BI Desktop now has improved matching capabilities regarding the data in your model:
	 •	Values are compared word-by-word rather than the entire value at once.  This allows for better matching in cases involving spelling-		
		  correction, plurals and punctuation, e.g.
			   o	 Spelling corrections: "How much kamut wheet was sold yesterday?" will match "kamut wheat" rather than just "kaput wheat" or "kamut wheet"
			   o	 Plurals: "Which employees are sales managers?" will now match "sales manager" rather than just "sales managers" or "sale manager"
			   o	 Punctuation: "Who works for Contoso Inc?" will now match "Contoso, Inc." rather than just "Contoso Inc"
	 •	Accent-insensitive matching is now used, allowing "Number of downloads of the latest Beyonce Knowles single" to match "Beyoncé Knowles"
	 •	 If you have plural values in your data, you can instruct Q&A to match singular values against them as well by setting the new 		
		  PluralNormalization property on the column in the Linguistic Schema, allowing "Which cashier was hired last week?" to match "cashiers" in 	
		  the data.

Q&A in Power BI Desktop Generally Available

Better matching experience for Power BI Desktop and Power BI Premium
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You can now pick data categories for measures.  This means you can do things like use measures to dynamically create URLs and mark the data 
category as a Web URL. T hen when you display it in tables, you’ll be able to click on the URL that’s created based on your selection!  This is especially 
useful if you want to link off to other Power BI reports with URL filter parameters:

Several new functions have been coded that expand the statistical capabilities of DAX.  They sort of flew under the radar in July’s update, but 
Microsoft has “announced” the following in this update:

	 •	NORM.DIST
	 •	NORM.S.DIST
	 •	NORM.INV
	 •	NORM.S.INV
	 •	 T.DIST
	 •	 T.DIST.RT
	 •	 T.DIST.2
	 •	 T.INV
	 •	 T.INV.2T.

These match the behaviours of their Excel counterparts, so it should be easy to migrate to if you’re used to doing these types of statistical operations 

in Excel.

Another example for this feature is to create DAX measures to create interesting insights such as sparklines using SVG images:

Data categories for measures

Statistical DAX functions

The Column Chart with Variance custom visual by 3AG Systems allows you to use multiple 
measures to create overlapping column charts with a variance chart positioned directly 
above.  This visual is geared towards showing actual, forecast, planned and previous year 
data.

3AG Systems - Column Chart with Variance
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The Scatter Chart custom visual by Akvelon allows you to view compare your different metrics with the x- and y-axes coordinates, point size and 
saturation.  It also supports rectangle selection for cross-highlighting other visuals on your report page.  The visual also supports drilling, constant 
lines on both axes and various formatting options.

The Small Multiples Line Chart created by independent programmer Daniel Marsh-Patrick allows you to display multiple line charts across the values 
of a category using the same scale and axes.  This makes it a lot easier to compare the trends across all values being compared.  The visual also lets 
you control the labels, the number of multiples per row and the background shading.

The Add Natural Language Summaries for BI custom visual by Arria 
NLG allows you to add narratives for the data you are displaying in 
your report.  The visual will generate natural languages that explains 
the most important insights and key drivers in your data.  Using Arria 

NLG’s NLG Studio, you’ll be able tweak starter projects or create your 
own templates to be used in your reports and have the narrative update 
based on your report’s filter context.

Scatter Chart by Akvelon

Small Multiples Line Chart

Add Natural Language Summaries for BI
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The Pivot Slicer custom visual goes beyond the built-in slicers, letting you 
dynamically pivot the slicer based on any combination of categorical data 
types, numerical data attributes and linked data items.  Some examples 
for this slicer include stacking multiple slicers in a single compact visual, 

exploring data rankings resulting from weighted combinations of 
numerical attributes and navigating the link structure of item hierarchies 
and networks.  Items of interest can be pinned from any view for 
comparison of attribute values, link weights and linked items.

Finally, the Spark connector has reached General Availability in this release.  The Spark connector can be found under the ‘Other’ category within 
the ‘Get Data’ dialog:

It enables you to create Import- or DirectQuery-based reports in Power BI against your data stored in Spark clusters.

Pivot Slicer

Spark connector Generally Available
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That’s all of the updates dealt with, but before we end this section, 
you may not have noticed, but Microsoft has been hinting more about 
future updates in Power BI Desktop.  They have been discussing various 
features, although the timescale for delivery is still unknown.  Having 
said that, you might want to anticipate the following:

	 •	 The ability to expand and collapse options for row headers in 		
		  matrix visuals.  With this feature, you’ll be able to expand 		
		  specific rows of your hierarchy to easily compare just a few values, 	
		  without having to see all the other values expanded as well.  This 	
		  was demonstrated at the Microsoft Business Application Summit

	 •	 There’s also talk of a “major extension to [Microsoft’s] scatter		
		  chart visual…”.  You’ll soon be able to use categorical data on your 	
		  x-axis, including hierarchical data, to create dot plots, while still 	
		  being able to take advantage of all of the formatting options 		
		  already available in scatter charts.

More updates and intel next month we’re sure!

Latest Updates for Power BI Report Server

So, this month it’s the Power BI Report Server that gets avalanched.  Those who don’t wish to read this may wish to skip to page 946 of this 
newsletter…

You can’t really accuse Microsoft of doing things by halves.  This release contains a fair few new features, including printing to PDF for Desktop, report 
theming, conditional formatting improvements and report page tooltips.  You should note that for those users who are upgrading their report server 
from a previous version, Microsoft recommends clearing your browser cache before viewing your reports.

The full list of new stuff is as follows:

Reporting

	 •	 Report Theming
	 •	Buttons to trigger actions
	 •	Combo chart line styles
	 •	 Improved default sort for visuals
	 •	Numeric range slicer
	 •	Advanced slicer syncing
	 •	 Log axis improvements
	 •	Data label options for funnel chart
	 •	 Set line stroke width to zero
	 •	High contrast support for reports
	 •	Donut radius control
	 •	 Pie and donut detail labels position control
	 •	 Format data labels separately for each measure in a combo chart
	 •	New visual header with more flexibility and formatting
	 •	Wallpaper formatting
	 •	 Tooltips for table and matrix
	 •	 Turn tooltips off for visuals
	 •	 Slicer accessibility
	 •	 Formatting pane improvements
	 •	 Stepped line support for line and combo charts
	 •	 Sorting experience improvement
	 •	 Print reports through Export to PDF (in Power BI Desktop)
	 •	Create bookmark groups
	 •	 Slicer restatement
	 •	Report page tooltips
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Analytics

	 •	New DAX function: COMBINEVALUES()
	 •	Measure drillthrough
	 •	Conditional formatting by a different field
	 •	Conditional formatting by values 

Modelling

	 •	 Filtering and sorting in data view
	 •	 Improved locale formatting
	 •	Data categories for measures
	 •	 Statistical DAX functions.

We’ll go through each in turn.  You might wish to pack a lunch.  And yes, we know there’s repetition with the last section…

First cab off the block for this release of Power BI Report Server is report 
theming, which will allow you to quickly colour your entire report to 
match a theme or corporate branding.  When you import a theme, all of 
your charts will automatically update to use the theme colours and you’ll 

have access to the theme colours from the color (sic) palette.

You can upload a theme file using the ‘Import Theme’ option under the 
‘Switch Theme’ button.

A theme file is a JSON file that includes all the colours you want us to use in your report along with any default formatting you want to apply to visuals.  
Here is a sample JSON theme that just updates the default colours of the report for egg-sample:

{

"name": "waveform",

"dataColors": [ "#31B6FD", "#4584D3", "#5BD078", "#A5D028", "#F5C040", "#05E0DB", "#3153FD", "#4C45D3", "#5BD0B0", "#54D028", "#D0F540", 
"#057BE0" ],

"background":"#FFFFFF",

"foreground": "#F2F2F2",

"tableAccent":"#5BD078"

}

When the theme is uploaded, the colours will automatically be applied to all charts.

Sunglasses are not included.  You’ll also see the colours in the color palette, so you will be able to use them in other places as well.

Report Theming
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Applied theme colours will follow your reports when you save them to Power BI Report Server.

Now that there are several different actions that can be triggered by 
just a click on a shape or image, Microsoft has decided it’s time to add 
a button control to Power BI as well.  These new buttons are geared 
towards letting you create an app-like experience with interactive 
elements in your report.

A button can be inserted from the Ribbon, by picking on of several icons 
or selecting a blank button.  Once on your page, you can choose to add 

text, change the icon, add a fill color or give your button an outline.  You 
have lots of control around the look of the icon and text including size, 
colour and alignment.  Once you pick your default look for your button, 
you can then use the dropdown to change how it looks on hover or when 
it is being clicked on.

You can now change your combo chart lines to different styles and have that optionally reflected in your legend.

As with images and shapes, you can pick the action that will be performed on click through the ‘Action’ card.  Currently, these actions include ‘Back’ 
and a specific bookmark.  For certain icon types, you will discover a default action has already been assigned.

Buttons to trigger actions

Combo chart line styles
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We understand that one of the goals of this update was to make it fast and easy for you to create well-formatted reports.  The default visual sort has 
been improved, so you won’t need to change it nearly as frequently.

The new logic for sorting visuals is:

	 1.	 If your visual uses a column that has an associated order-by column, it will sort by that by default (you can set this up using the ‘Sort by’ 	
		  column feature)
	 2.	 Otherwise, if your field is a date field, it will sort in chronological order
	 3.	 Finally, if you don’t have an order-by column or date field, it will sort by the measure descending.

Of course, as always, you can sort manually too.

The numeric range is Generally Available to use, and therefore, is now part of the Power BI Desktop for Report Server.  You’ll see it a slicer type 
option for numeric column without needing to turn on a Preview feature.  Additionally, any newly created slicers using numeric columns will 
default to the ‘between’ mode of the numeric range slicer.

You can also check the ‘Sync field changes to other slicers’.  With this option checked, if you swap the field used in the slicer, all the synced slicers 
will update to use the same field.

The ‘Advanced’ section of the ‘Slicer syncing’ pane allows you to create 
custom groups of slicers to synchronise.  By default, synchronised slicers 
will be put in a group with a name that matches the field used in the 
slicer, but you can override this with any name you want.  This means 
you can create separate groups to sync slicers that use the same field; 
for example, you may have two slicers using the same field on the same 
page, and you want to sync one of them with a slicer on another page.

You can also put slicers that use different fields in the same group; for 
example, you may have two different date fields and you want to have 
the selected date sync between the slicers.  If the value selected in the 
first slicer doesn’t exist in the second slicer, you’ll see it appear at the 
bottom of the list of values instead.

The log axis in cartesian charts has been improved in this update.  
You should now be able to select log scale for the numeric axis of any 
cartesian chart, including combo chart, when you have data that is 

completely positive or completely negative.  Reference lines should 
also observe the log scale and will cause the scale to resize in order to 
accommodate them.

If you have data that crosses zero, you’ll now get a helpful warning in the property pane, and the scale type will revert to linear.  Once your data is 
updated to no longer include both positive and negative values, the visual will start to use the log axis again.

Improved default sort for visuals

Numeric range slicer

Advanced slicer syncing

Log axis improvements
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This works for combo charts as well as line charts.

There’s now more control for data labels in a funnel chart.  You may now pick if each bar shows the actual value, the percentage of the first bar, the 
percentage of the previous bar or the actual value and one of the two percentage options.

Another small formatting option added is the ability to set the stroke width of lines to zero (0).

The first bar will always show only the data value since the percentages are always 100%.

Data label options for funnel chart

Set line stroke width to zero
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If you're using the high contrast mode Windows settings, your Power BI reports will now respect the color palette you're using.  When using Power BI 
Desktop, it will automatically detect which high contrast theme you're using and apply those colours across your report, similar to Excel

In Power BI Report Server, it will also try to detect which theme you're using and automatically apply it to your report, but depending on what browser 
you are using, it may not be able to.  If you want to change the theme manually, you can select a high contrast theme under the ‘View’ dropdown.

Note that if you're using high contrast themes on Power BI Desktop, you’ll still see some areas of the product that aren't using your theme’s colours.  
More support for high contrast will be available in future releases.

High contrast support for reports
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The ability to control the inner radius of a donut chart has now been added.  This lets you make the donut slimmer or thicker to get the style you 
want.  You’ll find this option under the ‘Shapes’ card in the ‘Formatting’ pane.

Pie and donut charts now support moving detail labels inside.  You can pick between forcing the labels to always be outside or inside or to prefer one 
position over the other.

There’s an update to data labels in combo charts in this release.  Now you can customise individual series.  In the ‘Data labels’ card of the ‘Formatting’ 
pane, you can turn the ‘Customize series option’ on to format an individual measure’s formatting options, such as colour, display units and the 
number of decimal points.

If you choose to move your labels inside the pie or donut chart, you can also choose whether the text can overflow past the edge of the shape and 
if the labels have a background or not.

Donut radius control

Pie and donut detail labels position control

Format data labels separately for each measure in a combo chart
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A common concern was that the visual’s header took up a lot of space 
and that it didn’t fit with the design of users’ reports.  Based off this 
feedback, Microsoft has completely revamped its visual header.

Since the new visual header is detached from the visual, it can adapt its 
position based on the layout of the visual.  By default, the header will 
appear inside the visual in line with the title.

If your visual doesn’t have a title, it will instead float on top of the visual, unless the visual is all the way to the top of the report, in which case it snaps 
to the bottom of the visual.

Every visual now has a new card in the ‘Formatting’ pane, called ‘Visual header’.  In this card, you’ll find options to format the icon colour, the 
background and border colours and their transparency.  You can also choose to turn off individual icons or the whole header for viewers of your report.

Note that the visibility toggles do not affect your report when authoring it.  You’ll need to 
publish your report and view it in reading mode to see the effect.  This is because many of the 
options in the visual header are important during editing, especially the warning icons.

This new visual header is on by default for all new reports.  For existing reports, you will 
need to enable it in the ‘Options’ dialog under the ‘Report settings’ section.  Depending upon 
your report’s layout, you may notice some shifts after upgrading reports to the new header, 
especially with background images.

New visual header with more flexibility and formatting
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With the new wallpaper feature, this update will now let you format that 
grey area outside your report page.  This lets you theme the entire report 
area and gives it a more cohesive feel.  The formatting options you have 
are similar to what you currently have for report pages, including colour, 
transparency and uploading an image.  You can set the wallpaper per 

page or use our theming feature to set a new default experience for all 
your report pages.

This feature can be used to extend the main colour of any background 
images you are using for layouts to the rest of the space.

Based on end user feedback, Microsoft has decided to close the gap 
between table and matrix and other visuals in terms of tooltips.  The 
software now supports the standard tooltips on both the table and 
matrix visuals.

You’ll be able to turn tooltips on for table and matrix using the new 
tooltip card.  Tooltips will be set by default to off, so you don’t need to 
worry about your reports changing without you knowing.

You can also make your report page transparent and have your charts float on top of the wallpaper.

which can give your report a very different feeling depending on the image used.

You’ll notice that when the page background has a transparency higher that 50%, the update will add a grey dotted line in editing mode to help you 
see where the edge of your page is.

As part of this update, Microsoft has also updated the default report page experience to have a completely transparent page background and a white 
wallpaper, which probably has a more professional look than a white page and grey wallpaper.

Wallpaper formatting

Tooltips for table and matrix
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Once the tooltip card is turned to on, you’ll get the standard Power BI tooltip for your visual.

Based on end user feedback, Microsoft has decided to close the gap 
between table and matrix and other visuals in terms of tooltips.  The 
software now supports the standard tooltips on both the table and 
matrix visuals.

You’ll be able to turn tooltips on for table and matrix using the new 
tooltip card.  Tooltips will be set by default to off, so you don’t need to 
worry about your reports changing without you knowing.

Being able to interact with and change slicer values is one of the most 
important tasks for any report consumer, and for a while this wasn’t 
available to users who relied solely on a keyboard to navigate.  Rather 
than send everyone a mouse, Microsoft has announced that with this 
update keyboard and screen reader users can now go beyond consuming 
a report as is and can start interacting with slicers on their reports.

When you want to explore the current state of a slicer using just a 
keyboard, the first thing you’ll need to do is enter into the slicer.  You can 
do this with the CTRL + Right Arrow keyboard shortcut.  This will move 

your focus to the first element inside the slicer.  You can then tab around 
the various components of the slicer, such as the clear icon, dropdowns 
and text fields to update values and the slicer type dropdown.  As your 
focus moves, helpful information is also read out by the screen reader, 
if you have one on.

This is a big step forward in terms of accessibility and apparently, there 
are even more accessibility features planned for the coming months.  
Stay tuned.

If you are a report author, you probably spend a lot of time in the ‘Formatting’ pane updating the design 
of your visuals.  Given its usage and the fact that it was originally designed when there were not many 
formatting options available, Microsoft has been wanting to revamp this for quite a while.  

Hence, there are now updates:

	 •	 A lighter grey color used inside cards, so the entire pane doesn’t blend together
	 •	 Animations and hover effects give the pane a more modern and polished feel
	 •	 Titles show above a given control to improve readability and reduce truncation.

Turn tooltips off for visuals

Slicer accessibility

Formatting pane improvements
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As a small formatting improvement, this update now supports changing the line in combo charts to a stepped format.  You’ll find this toggle in the 
‘Shapes’ card.  The type of stepped line currently supported changes height at the midpoint between two data points.

Microsoft discovered through user testing that the end user sort experience wasn’t very clear or easy to use and wasn’t accessible to keyboard users.  
This has now been improved by separating the controls to change sort direction from the control to pick the field to sort by.  With this change, you 
can now also fully navigate this options flyout using only a keyboard.

This should have been the headline announcement.  Microsoft has said 
that they have “…heard loud and clear…” that an option was required in 
Power BI Desktop to easily print or email copies of reports out to others 
in the same company.  Believe it or not, Microsoft has been working on 

a solution to this problem for a while now and this month’s update now 
allows you to export all visible report pages to PDF.  You’ll find this new 
option under the ‘File’ menu.

Stepped line support for line and combo charts

Sorting experience improvement

Print reports through Export to PDF (in Power BI Desktop)
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Once you select ‘Export to PDF’, the software will start generating the 
PDF.  While it’s doing this, it will also show you a dialog letting you know 
progress, and you’ll see each non-hidden page loading in order behind it.  

During this process, you won’t be able to interact with the report.  If you 
need to interact with your report again before we’ve finished you will 
need to cancel the export through the dialog.

Once the PDF has been created, it will open in your default PDF viewer.  From there, you can save it wherever you like, email it as an attachment, or 
even go old school and print it.

Currently, this update does not support printing wallpaper colour or images, only page backgrounds or images.  If you have a dark wallpaper colour 
and a transparent page colour, you may want to temporarily set the page background to match the wallpaper’s colour to improve readability.

If you are using bookmarks extensively, you will probably have sets of 
bookmarks for different purposes.  For example, you may have different 
bookmarks per organisational division using your report, or perhaps you 
have a set of bookmarks for navigation and several sets of bookmarks for 
different presentations.

In these cases, it’s important to clearly separate out each group of 
bookmarks, and this month, this update makes it easier to do with the 
introduction of bookmarking grouping.  Bookmark grouping lets you 
collect a set of bookmarks together and give it a name.  Each group can 
be expanded and collapsed for easy viewing.

Create bookmark groups
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To create a bookmark group, click the first bookmark of the group and then CTRL + Click the other bookmarks you want to group with it.  Then select 
the “…” menu for any of the bookmarks to group and pick the group option.

If you decide later you don't want that group anymore, just use ‘Ungroup’ to stop grouping that set of bookmarks.

When you use ‘View’ to play a bookmark group, it will only include the bookmarks in that group.

Playing from a bookmark at the root level, such as ‘Default View’ in this example, will still play through all bookmarks in your pane.
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I am beginning to feel this whole newsletter is in repeat mode!  The 
problem is, people only read what is relevant to them so apologies for 
the duplication.  The problem is, people only read what is relevant to 
them so apologies for the duplication.  The problem is, people only read 
what is relevant to them so apologies for the duplication.  The problem 

is, people only read what is relevant to them so apologies for the 
duplication… (Groan! Ed.)

If you are using the list slicer, you can now add a restatement, similar to 
the restatement in the dropdown slicer, to the slicer header through an 
option in the ‘Slicer header’ card in the ‘Formatting’ pane.

This feature lets you design a report page to be used as a custom tooltip 
for other visuals in your report.  This gives you full flexibility to design 
whatever kind of custom tooltips you want, from using cards to show 
detailed information to miniature drillthrough pages shown on hover.

To start creating your custom report page tooltips, first you have to 
design the tooltip you want to show.  We recommend you use a smaller 

page size, so you don’t have to worry about the tooltip being too large 
to show on your normal report pages.  Microsoft has added a new page 
size template called Tooltip to use as a starting point, but you can use 
any page size you want.

While designing your tooltip, we recommend viewing it in ‘Actual’ size, so you know exactly what your tooltip will look like on hover.

Once you’ve finished creating your tooltip report page, you’ll need to mark the page as a tooltip so Power BI knows you want to use it as such.

Slicer restatement

Report page tooltips
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From here, there are two ways you can start using this tooltip in your 
report.  The first is to tie it to a specific field using the ‘Tooltip fields’ 
bucket below the ‘Filters’ pane.  This behaves similarly to the drillthrough 
fields bucket.  Any fields you put into the tooltip fields bucket will be tied 
to this tooltip.  If you use this field in charts throughout your report, this 

tooltip will be used instead of the default Power BI tooltip.  You can put 
both categorical and numerical fields in this bucket, including measures.

For example, if you put SalesAmount in the Tooltip fields bucket,

That page will be used as a tooltip in other visuals using the SalesAmount field.

The other way you can tie a custom tooltip page to your visuals is to 
manually set it through the ‘Tooltip’ card in the ‘Formatting’ pane.  In 
the card, you can set any page that’s marked as a Tooltip page, even if 

it doesn’t have anything in the Tooltip field bucket, to be the tooltip for 
this visual.  This is useful if you want to design a tooltip to be used for a 
specific visual.

Another use case is to manually override the automatically selected tooltip if Power BI picked the 
wrong one to use.  For example, in the chart above, if you had one tooltip tied to the ‘Units’ field and 
one tied to the ‘Category’ field (the two fields used to create the chart), Power BI would pick one of 
these tooltips to use automatically.  If you didn’t like the tooltip selected, you can use this manual 
override to pick the other one.

If you manually override the tooltip in this card, you can always go back to the ‘automatic’ selection by 
selecting ‘Auto’ in the dropdown list.  You can also completely turn the report page tooltips off for a 
chart by setting  the tooltip type dropdown to ‘Default’.  This will force a chart to use Power BI’s default 
tooltip, even if there are matching report page tooltips in the report.
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There are a couple of other things to consider when building report page tooltips.  Firstly, when using these custom tooltips for line charts, you will 
only get one tooltip for all lines in the chart, as you do today.  The field in the legend does not get passed through as a filter on the tooltip.  In the 
example below, the tooltip is showing all units sold on that day across all three classes: Deluxe, Economy, and Regular: 

Secondly, when a chart is being cross-highlighted, the report page tooltips will always show the cross-highlighted data, even if you are hovering over 
the “faded out” section of the data point.  To see the unfiltered data in the tooltip, you will need to clear the highlighting.

This month’s update adds a new DAX function COMBINEVALUES(), that allows multi part keys to be handled in a more efficient way when using 
DirectQuery.  

Power BI doesn’t directly support relationships that use multi-part keys.  For example, consider the relationship between Shipment, and OrderLine 
(say).  If an OrderLine is uniquely identified by a combination of OrderID and LineID, then the relationship from Shipment to OrderLine would need to 
use those pair of columns.  The common workaround is to create a calculated column on each table, that combines the values with some separator.  
For example:

Key = CONCATENATE(CONCATENATE([OrderID],":"),[LineID])

Then the relationship can be defined as normal.  The problem with this workaround is when you're using DirectQuery since now cases which require 
a join between the two tables will send a SQL query that joins on an expression.  This often results in indices no longer being used, and therefore a 
less efficient query.

This new COMBINEVALUES takes as arguments a separator (e.g. “:”) and one or more expressions.  It will concatenate the values of all the expressions, 
with the given separator.  For example, in the case above, the calculated column can now be defined using the expression:

Key = COMBINEVALUES(":",[OrderID],[LineID])

This is still simply a DAX expression, and the calculated columns are still used in the relationship as before.  The difference is that this is then 
optimised, such that upon joining using this relationship, the condition defined in the SQL query decomposes back to use the underlying columns 
[OrderID] and [LineID] directly.  This generally results a much more efficient SQL query.

As another use case for this new DAX function, you might also want to use this function to join a set of values with a common delimiter without having 
a set of nested CONCATENATE() functions.

New DAX function: COMBINEVALUES()
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In the previous Power BI Report Server release, Microsoft added a drillthrough experience that allows you to move from one page to another carrying 
specified filters through.  You’d set this up by creating your drillthrough page (i.e. the page you want to land on) and then adding any categorical fields 
to the Drillthrough filters bucket in the filter pane as you want.

Any fields you put in this bucket would be tied to the page.  Any chart 
in the rest of the report that uses that field could be right-clicked on to 
move to the drillthrough page.

This is a very powerful feature but was limited that only filters on the 
fields explicitly placed in the Drillthrough filters bucket would be carried 
through.  There was no way to carry the entire filter context of your data 
point through the drillthrough page.

Microsoft is closing this gap by allowing you to carry all filters through.  
When you are setting up your drillthrough page, if you want all filters to 
pass through and not just the fields placed in the bucket, you can turn 
the ‘Pass all filters’ toggle on.

Once the toggle is on, whenever you right click on a data point and drillthrough, all filter context from the source page is passed to the drillthrough 
page.  You’ll be able to see a restatement of all these filters in the Drillthrough bucket.

The ‘Pass all filters’ option is on by default for new drillthrough pages and off by default for existing pages.

With the toggle turned off, only filters on the columns specified will be carried through.

With this drillthrough update, you can also now use measures and summarised numeric columns in the drillthrough bucket.  You can pick if you want 
to allow drillthrough on numeric columns when used as a category (e.g. a chart showing number of reviews by rating) or summarised (e.g. a chart 
showing average rating by category).

Measure drillthrough
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There’s a major improvement regarding conditional formatting, i.e. the 
ability to formatting a column by a different field in your model.

Now, whenever you open the conditional formatting dialog, you’ll see 
two new dropdowns.  The first, ‘Based on field’, is where you can pick 

what field from your model to base your rules on, and the second, 
‘Summarization’, is where you’ll pick the aggregation type for that field.  
You'll be able to see what field in your table or matrix is being formatted 
currently through the title of the dialog.

The field and summarisation type to colour by are auto-populated with the same column in your table you’ve chosen to format, so you won’t have 
to do any extra configurations unless you want to customise it.

When you do customise the field for the colour to be based on, you’ll get a similar experience to the field list where you can expand and collapse 
tables in your model and search to help you find the field you’re looking for.

In the below example, we are using showing the total sales by product and colouring that column by the average net satisfaction of the product.

Conditional formatting by a different field
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You can also pick a new source of formatting when using the ‘Color by’ rules version of conditional formatting.

With this update, Power BI is also opening up conditional formatting to text and date fields as well, as long as you choose a numeric value to format on.

A common use case for this would be to create a measure in your model 
that does your custom business logic, such as comparing target with 
actuals and then use ‘Color by’ rules to format the text based on the 
result.  For example, you could create a measure to return a -1, 0, or 1 if a 

product is under, at, or above its sales expectations, and then in ‘Color by’ 
rules mode chose to format the product name red if the measure returns 
-1, yellow if it returns 0 and green if it returns 1.

Another new conditional formatting type this month is ‘Format by 
field value’.  This will let you use a measure or column that specifies a 
colour, either through a hex code or name and applies that colour to the 
background or font colour.

For example, each product in my model has a colour. Instead of showing 
the colour name, we’d prefer if the cell were filled with the colour 
instead.

With this feature all we have to do is pick to format that colour by the colour name.  We’ll do that by opening the conditional formatting dialog for 
the Color column in the table

and then in the dialog, pick to format by Field value.  The dialog defaults to the ‘Color’ column with ‘First’ for ‘Summarization’.  Since we are always 
only going to have one colour value per table row, this is exactly what we want.

Conditional formatting by values 
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If we repeat this for font colour as well, the whole column will be filled with the product colour, which makes it easier for us to identify with a glance 
which product colour we are currently looking at.

Another great use case for this is to set up a DAX calculation based on your business logic that outputs different hex codes.  You can then format 
by that calculation without having to worry about creating a set of rules in the conditional formatting dialog.  For example, you could use a switch 
statement to create your KPI…

… pick to conditionally format by that measure…

… and see the results in your table or matrix.

Next up is the addition of filtering and sorting in the data view.  For every column in your model, you can now see the sort direction if it is applied on 
that column and either filter individual values out or using advanced filtering options for that column type.

Filtering and sorting in data view
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Microsoft is increasing the number of specific locales it supports for 
formatting when viewing your reports in Power BI Report Server.  With 
this update, they have added support for a total of 670 locales!  For 
example, you’ll now see support for Mexico’s variant of Spanish along 

with many other Spanish variants.  In Desktop, we detect and use the 
‘date, time and number formatting’ format set for the operating system.  
Internet Explorer and Edge will pass this same OS locale through, but other 
browsers often have their own, separate, language and region settings.

Make sure to use the default data format for your field if you want the system locale settings to flow through.  You can tell you are using system locale 
formatting by the * next to the format.

Improved locale formatting
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You can now pick data categories for measures.  This means you can do things like use measures to dynamically create URLs and mark the data category 
as a Web URL.  Then when you display it in tables, you’ll be able to click on the URL that’s created based on your selection!

Several new functions have been coded that expand the statistical capabilities of DAX.  They sort of flew under the radar in July’s update, but 
Microsoft has “announced” the following in this update:

	 •	 NORM.DIST
	 •	 NORM.S.DIST
	 •	 NORM.INV
	 •	 NORM.S.INV
	 •	 T.DIST
	 •	 T.DIST.RT
	 •	 T.DIST.2
	 •	 T.INV
	 •	 T.INV.2T.

These match the behaviours of their Excel counterparts, so it should be easy to migrate to if you’re used to doing these types of statistical operations 
in Excel.

Phew!  Congratulations on making the end of that section.  Don’t ask me how long that took Microsoft and then me to put together!!

Another great use case for this feature is to create DAX measures to create interesting insights such as sparklines using SVG images.

Data categories for measures

Statistical DAX functions

The A to Z of Excel Functions: COUPDAYBS

We’re planning a coup this month with lots of COUP functions!

Bonds that pay interest prior to maturity are known as coupon bonds.  
When you purchase such a bond, you should know how far into a coupon 
period you are buying the bond, so you can tell how long you'll have 

to wait to receive your first interest payment.  You can calculate the 
number of days between the coupon beginning and settlement date 
using the coupon days between beginning settlement function, which is 
abbreviated to COUPDAYBS.  This function returns the number of days 
from the beginning of a coupon period until its settlement date.

The COUPDAYBS function employs the following syntax to operate:

COUPDAYBS(settlement, maturity, frequency, [basis])

The COUPDAYBS function has the following arguments:

	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security is 	
		  traded to the buyer
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	 •	maturity: this is the security's maturity date, i.e. when the security expires
	 •	 frequency: The number of coupon payments per year.  For annual payments, frequency is 1; for semiannual, frequency is 2; for quarterly, 	
	 	 frequency is 4.  These are the only options (see below)
	 •	basis: the type of day count basis to use.  This is optional.  There are five options:

It should be further noted that: 
	 •	Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, 	
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900
	 •	dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the  
		  29th of February, 2020.  Problems may occur if dates are entered as text
	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be January 	
		  1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 2008, issue 	
		  date
	 •	 all arguments are truncated to integers
	 •	 if settlement or maturity is not a valid date, COUPDAYBS returns the #VALUE! error value
	 •	 if frequency is any number other than 1, 2, or 4, COUPDAYBS returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, COUPDAYBS returns the #NUM! error value
	 •	 if settlement ≥ maturity, COUPDAYBS returns the #NUM! error value.

Please see our example below: 

Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

The A to Z of Excel Functions: COUPDAYS

When you invest in a coupon bond, that is a bond that pays interest before maturity, you can evaluate your investment more accurately if you know 
the number of days in the coupon period.  To find that value you can use the COUPDAYS function, which is short for coupon days.  

The COUPDAYS function employs the following syntax to operate:

COUPDAYS(settlement, maturity, frequency, [basis])

The COUPDAYS function has the following arguments:

	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security is 	
		  traded to the buyer
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	 •	maturity: this is the security's maturity date, i.e. when the security expires
	 •	 frequency: The number of coupon payments per year.  For annual payments, frequency is 1; for semiannual, frequency is 2; for quarterly, 	
	 	 frequency is 4.  These are the only options (see below)
	 •	basis: the type of day count basis to use.  This is optional.  There are five options:

It should be further noted that: 

	 •	Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, 	
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900
	 •	dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the 	
		  29th of February, 2020.  Problems may occur if dates are entered as text
	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be January 	
		  1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 2008, issue 	
		  date
	 •	 all arguments are truncated to integers
	 •	 if settlement or maturity is not a valid date, COUPDAYS returns the #VALUE! error value
	 •	 if frequency is any number other than 1, 2, or 4, COUPDAYS returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, COUPDAYS returns the #NUM! error value
	 •	 if settlement ≥ maturity, COUPDAYS returns the #NUM! error value.

Please see our example below: 

Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

The A to Z of Excel Functions: COUPDAYSNC

Coupon bonds pay interest at regular intervals, either one, two or four times a year.  In Excel, you can use the COUPDAYSNC function to calculate the 
number of coupon days from the settlement date to the next coupon date. 

The COUPDAYSNC function has the following arguments:

	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security is 	
		  traded to the buyer
	 •	maturity: this is the security's maturity date, i.e. when the security expires
	 •	 frequency: The number of coupon payments per year.  For annual payments, frequency is 1; for semiannual, frequency is 2; for quarterly, 	
	 	 frequency is 4.  These are the only options (see below)
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	 •	basis: the type of day count basis to use.  This is optional.  There are five options:

Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

It should be further noted that: 

	 •	Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, 	
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900
	 •	dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the 	
		  29th of February, 2020.  Problems may occur if dates are entered as text
	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be January 	
		  1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 2008, issue 	
		  date
	 •	 all arguments are truncated to integers
	 •	 if settlement or maturity is not a valid date, COUPDAYSNC returns the #VALUE! error value
	 •	 if frequency is any number other than 1, 2, or 4, COUPDAYSNC returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, COUPDAYSNC returns the #NUM! error value
	 •	 if settlement ≥ maturity, COUPDAYSNC returns the #NUM! error value.

Please see yet another example below: 

The A to Z of Excel Functions: COUPNCD

Coupon bonds are bonds that pay interest prior to maturity and those interest payments are paid on a regular schedule which can occur either 
one, two or four times a year.  After you take possession of the bond, you can calculate the calendar date of your next coupon date using the 
COUPNCD function.

The COUPNCD function employs the following syntax to operate:

COUPNCD(settlement, maturity, frequency, [basis])

The COUPNCD function has the following arguments:

	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security is 	
		  traded to the buyer
	 •	maturity: this is the security's maturity date, i.e. when the security expires

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

	 •	 frequency: The number of coupon payments per year.  For annual payments, frequency is 1; for semiannual, frequency is 2; for quarterly, 	
	 	 frequency is 4.  These are the only options (see below)
	 •	basis: the type of day count basis to use.  This is optional.  There are five options:

Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

It should be further noted that: 

	 •	Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, 	
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900
	 •	dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the 	
		  29th of February, 2020.  Problems may occur if dates are entered as text
	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be January 	
		  1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 2008, issue 	
		  date
	 •	 all arguments are truncated to integers
	 •	 if settlement or maturity is not a valid date, COUPNCD returns the #VALUE! error value
	 •	 if frequency is any number other than 1, 2, or 4, COUPNCD returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, COUPNCD returns the #NUM! error value
	 •	 if settlement ≥ maturity, COUPNCD returns the #NUM! error value.

Please see my example below:

The A to Z of Excel Functions: COUPNUM

A coupon bond is a bond that pays interest before maturity.  Once you own the bond, you can calculate the number of coupon payments you will 
receive over the life of the bond by using the COUPNUM function.  Essentially, this function returns the number of coupons payable between the 
settlement date and maturity date, rounded up to the nearest whole coupon.

The COUPNUM function employs the following syntax to operate:

COUPNUM(settlement, maturity, frequency, [basis])

The COUPNUM function has the following arguments:

	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security is 	
		  traded to the buyer
	 •	maturity: this is the security's maturity date, i.e. when the security expires
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	 •	 frequency: The number of coupon payments per year.  For annual payments, frequency is 1; for semiannual, frequency is 2; for quarterly, 	
	 	 frequency is 4.  These are the only options (see below)
	 •	basis: the type of day count basis to use.  This is optional.  There are five options:

Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

It should be further noted that: 

	 •	Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, 	
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900
	 •	dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the 	
		  29th of February, 2020.  Problems may occur if dates are entered as text
	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be January 	
		  1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 2008, issue 	
		  date
	 •	 all arguments are truncated to integers
	 •	 if settlement or maturity is not a valid date, COUPNUM returns the #VALUE! error value
	 •	 if frequency is any number other than 1, 2, or 4, COUPNUM returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, COUPNUM returns the #NUM! error value
	 •	 if settlement ≥ maturity, COUPNUM returns the #NUM! error value.

An example: 

The A to Z of Excel Functions: COUPPCD

A coupon bond is a bond that pays interest before the bond matures.  That interest is paid on a regular schedule and in Excel that can be either 
annually (once a year), semiannually (twice a year), or quarterly (four times a year).  If you're thinking about investing in a coupon bond before its 
initiation date, i.e. the first day that the bond is available, then you can calculate the calendar date of the most recent coupon payment by using 
the COUPPCD function.  This function returns a number that represents the previous coupon date before the settlement date.

The COUPPCD function employs the following syntax to operate:

COUPPCD(settlement, maturity, frequency, [basis])

The COUPPCD function has the following arguments:

	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security is 	
		  traded to the buyer
	 •	maturity: this is the security's maturity date, i.e. when the security expires
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	 •	 frequency: The number of coupon payments per year.  For annual payments, frequency is 1; for semiannual, frequency is 2; for quarterly, 	
	 	 frequency is 4.  These are the only options (see below)
	 •	basis: the type of day count basis to use.  This is optional.  There are five options:

Basis Day count basis

0 or omitted US (NASD) 30 / 360

1 Actual / actual

2 Actual / 360

3 Actual / 365

4 European 30 / 360

It should be further noted that: 

	 •	Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1, 	
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900
	 •	dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the 	
		  29th of February, 2020.  Problems may occur if dates are entered as text
	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For 	
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be January 	
		  1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1, 2008, issue 	
		  date
	 •	 all arguments are truncated to integers
	 •	 if settlement or maturity is not a valid date, COUPPCD returns the #VALUE! error value
	 •	 if frequency is any number other than 1, 2, or 4, COUPPCD returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, COUPPCD returns the #NUM! error value
	 •	 if settlement ≥ maturity, COUPPCD returns the #NUM! error value.

Please see our final example below: 

Upcoming SumProduct Training Courses

Location Course Date Duration

Sydney Power Pivot, Power Query and Power BI 10 - 12 Sep 2018 3 days

Perth Financial Modelling 17 - 18 Sep 2018 2 days

Perth Power Pivot, Power Query and Power BI 19 - 21 Sep 2018 3 days

Sydney Excel Tips and Tricks 8 Oct 2018 1 day

London Financial Modelling 8 - 9 Oct 2018 2 day

Sydney Financial Modelling 9 - 10 Oct 2018 2 day

Brisbane Excel Tips and Tricks 15 Oct 2018 1 day

Adelaide Financial Modelling 22 - 23 Oct 2018 2 day

Melbourne Excel Tips and Tricks 29 Oct 2018 1 day

Melbourne Financial Modelling 30 - 31 Oct 2018 2 day

Darwin Power Pivot, Power Query and Power BI 12 Nov 2018 1 day
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www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd, Suite 52, Level 10, 88 Pitt Street, Sydney, NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne, VIC 3000
Registered Address:	SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne, VIC 3004

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, it’s time to combine 
CONTROL with SHIFT:

Keystroke What it does
CTRL + SHIFT + F3 Create names
CTRL + SHIFT + F4 Find previous (from most recent search)
CTRL + SHIFT + F6 Previous Window / Workbook
CTRL + SHIFT + F12 Print
CTRL + SHIFT + Down Arrow Extend selection down to last cell in area down

CTRL + SHIFT + End Extends the selection to the last cell (by final row and final column) in the sheet
CTRL + SHIFT + ENTER Fill value in edited cell into all cells and do not move
CTRL + SHIFT + ESC Task Manager (for Windows: overrides an Excel command)
CTRL + SHIFT + Execute Fill value in edited cell into all cells and do not move
CTRL + SHIFT + Left Arrow Extend selection down to last cell in area left
CTRL + SHIFT + Page Down Extend selection one sheet down (to the right)
CTRL + SHIFT + Page Up Extend selection one sheet up (to the left)
CTRL + SHIFT + Return Fill value in edited cell into all cells and do not move
CTRL + SHIFT + Right Arrow Extend selection down to last cell in area right
CTRL + SHIFT + Space Select contiguous area
CTRL + SHIFT + TAB Previous Window
CTRL + SHIFT + Up Arrow Extend selection up to the end of the region
CTRL + SHIFT + A Insert arguments in formula
CTRL + SHIFT + B Address book (only when emailing not as an attachment)
CTRL + SHIFT + F Font face
CTRL + SHIFT + L Toggle AutoFilter
CTRL + SHIFT + O Select Comments
CTRL + SHIFT + P Font size
CTRL + SHIFT + T Toggle Total Row

Sydney Power Pivot, Power Query and Power BI 12 - 14 Nov 2018 3 day

Melbourne Excel Tips and Tricks 19 - 21Nov 2018 3 day

Sydney Excel Tips and Tricks 10 Dec 2018 1 day

Sydney Financial Modelling 11 - 12 Dec 2018 2 day

Sydney Power Pivot, Power Query and Power BI 17 - 19 Dec 2018 3 day


